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Introduction
The Quality Control module is designed to enhance Manfact’s Quality Assurance module by providing a
modern user interface along with a variety of special features aimed at streamlining the inspection
process.
The Supplier Corrective Action Notice (SCAR) application complements the Quality Control module by
formalizing the process of reporting defects in purchased parts, notifying the supplier that corrective
action is required, and allows the user to decide whether the Supplier’s performance rating should be
impacted by the event.
Features of the Quality Control module include the ability to:
•

QA Specification Codes define inspection requirements and statistical sampling plans.

•

Search for Manfact QA records using a variety of search criteria

•

View details of a QA record including all previous dispositions and stock transactions

•

Enter details about the inspection, including Manufacturer information

•

Accept or reject a QA lot

•

Create and email a Non-Conforming Material Report (NMR)

•

Retain the NMR Document and related Attachments in the NMR Data Store

•

Disposition a rejected QA lot

•

Require Approval of certain Disposition types before the QA record is finalized

•

Send email notifications to request NMR Disposition Approval

•

Enter NMR Disposition Approval or Refusal by clicking a link in the email message

•

Create Stock transactions to move parts in/our of QA Controlled locations.

•

Locate drawings and other electronic files in an electronic data store

•

Generate an Inspection Report including QA Inspection History for the Part Number

The Supplier Corrective Action Request application includes the following major components:
•

Create, view and modify Supplier Corrective Action Requests.

•

Provides documentation for in-house repairs of defective parts.
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•

Record failures and impact supplier performance rating without generating a debit memo.

•

Email notifications may be automatically sent to the Supplier, with the SCAR attached as a Word
document or PDF file.

•

Integration with the NorthClark Supplier Portal Web Site.

The Quality Control Module serves the needs of three separate functional areas: Receiving Inspection,
the Material Review Board, and Supplier Quality Management. When purchased parts are received, the
system determines whether inspection is required based on various parameters. Certain parts always
require inspection, others are transferred directly to stock, and some are occasionally inspected based on
“skip lot” criteria.
When a part requiring inspection is received, it will be moved to the Receiving Inspection location. At
least one RI location should be created for each Warehouse. In the Manfact system, the RI location will
be designated as a “QA” Location, meaning that each transfer will be assigned a unique QA
Identification Number. The QA Identifier is essentially a temporary Lot Number that will be used to
track the progress of the parts through the inspection process.
Each lot to be inspected is assigned a Specification Code. The Specification Code is initially obtained
from the Parts master file, but may be changed to accommodate special circumstances. The
Specification Code describes the type of inspection to be performed, along with rules for calculating
sample sizes and rejection criteria.
When parts pass inspection, they are immediately transferred to Stock, and no further updates are
required. Rejected items are transferred to the Material Review Board location for disposition. Note that
the MRB location must also be identified as a “QA” location, as every item moved in or out of the
location must be controlled by the QA Identifier.
When parts are rejected, the Inspector will generate a Non-Conforming Material Report (NMR). This
document may be printed and/or emailed to the responsible people on the Material Review Board. The
NMR includes pertinent information such as the QA Identifier, Part Number, Supplier, Rejected
Quantity, the reason for rejection, and so forth. The Material Review Board reviews the NMR, and
decides on the appropriate course of action. For example, the parts may be scrapped, repaired, used as is,
or returned to the supplier.
Entering the proposed disposition of rejected parts on the NMR will initiate the approval process. The
number of approvals required depends on the Disposition Code. An email notification will be sent to
each potential approver, with a copy of the NMR document attached. A link in the email message will
direct the user to a web page where they may choose to approve or refuse the proposed disposition.
Once it has been determined that a lot is defective, and Supplier notification is required, the SCAR
module may be invoked to create the Supplier Corrective Action Request. The SCAR will reference the
NMR (QA record) identifier, allowing pertinent inspection information to be included without redundant
data entry.
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The Disposition Code assigned to a defective lot identifies additional follow-up documents that will be
required: Engineering Change Request, Corrective Action Request (internal), Supplier Corrective Action
Request and Debit Memo. The QA record will be finalized only when all of the required document
numbers and signatures have been posted.
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Quality Control Module

The Main screen of the Quality Control application is comprised of the following tabs:
1. Search Options

Locate existing QA records using a variety of search criteria

2. Results

The Results tab displays a list of QA records generated from the search

3. Detail

Displays information for a QA record selected from the Results tab

4. Inspection

Displays Manufacturer information, Sampling Plan and Inspection Steps

5. Accept / Reject

Enter the Inspection Results.

6. Stock

Move parts in or out of the RI and MRB inventory locations.

7. NMR

Non-conforming Material Report.

8. Disposition

Disposition rejected items.

9. Returns

Returns to Supplier
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Search Options
QA records are created automatically in the Manfact system when a qualifying part is received into a
Quality Inspection location. Recording information about the inspection process begins by locating the
desired QA record.
The fields on the Search Options display may be used in any combination to narrow your search (leave
the field blank if you do not wish to consider it in the search). Wildcarding is supported for text fields.
Once the desired selection criteria have been entered, click the Search button, and the list of qualifying
records is displayed on the Results tab.
Search Filters:
QA ID

Enter a specific QA Identifier

Part Number

Enter the Part Number or use the Part Number Search Query.

Lot Number

The Lot Number assigned by the Manfact inventory control system.

Product Class

Select the Product Class from the drop-down list.

Product Sub Class

Select the Product Sub Class from the drop-down list.

QA Spec Code

Enter the QA Spec Code or use the QA Spec Code Search screen.

Supplier

Enter the Supplier identifier or use the Supplier Search function.

Warehouse

The Warehouse associated with the QA Receiving Inspection location.

Creation Date

Click the Start Date and End Date checkboxes, then enter the start and end dates
that you want to use for your search criteria.

Source Types

Select the Source Types to include by clicking on the radio buttons. To select all
Source Types, click Not Apply.

Status

Check all that apply. Note that a QA record may meet multiple criteria:
Needs Inspection: Items awaiting action by Receiving Inspection
Needs Disposition: Items awaiting action by the Material Review Board
Ready to Move: Units are ready to be moved out of the RI or MRB location. This
includes units that have passed inspection, as well as rejected items where the
disposition has been entered.
Complete: All items have been moved out of the RI and MRB locations.
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Final: All required signatures and document numbers and have been posted.
Needs Notification: Disposition transactions are awaiting Approval, and a
notification has not been sent. If you check this box, and Approval is needed, the
record will be selected regardless of Status.
Needs Approval: Disposition transactions are awaiting Approval. If you check this
box, and Approval is needed, the record will be selected regardless of Status.
Approval Refused: Approval has been denied on an open Disposition transaction.
If you check this box, and Approval is needed and has been refused, the record will
be selected regardless of Status.
Needs Documents: Document numbers (ECR, CAR, SCAR, Debit Memo) need to
be entered. If you check this box, and document numbers are required, the record
will be selected regardless of Status.
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Results
After you choose the Search command, the resulting list of QA records are displayed on the Results tab
in spreadsheet format. You will be able to print the results or export to Excel. Data may not be updated
using this tab.
Select a record to update by double-clicking on the desired row.

Search Results Columns:
QA#

System assigned QA record identifier.

Part Number

Part Number to be inspected.

Description

Part Description

Part Revision

The Revision Level of the Part.

Supplier ID

Identifier of the Manfact Vendor file.

Supplier Name

Supplier’s Company Name
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Status

Active – Some or all of the parts are still in the RI or MRB location.
Complete – All parts have been moved out of the RI and MRB locations.
Final – All required signatures and document numbers have been posted.

QA Lot Qty

Total quantity issued to the inspection location.

Needs Inspection

Total quantity awaiting inspection.

Needs Disposition

Total quantity awaiting disposition.

Ready to Move

Quantity ready to move out of RI and/or MRB.

Accept Qty

Quantity that passed inspection.

Reject Qty

Quantity rejected.

Needs Notice

Disposition transactions are awaiting Approval, and a notification has not been
sent.

Needs Approval

Disposition transactions are awaiting Approval.

Approval Refused

Approval has been denied on an open Disposition transaction.

Needs Docs

Document numbers (ECR, CAR, SCAR, Debit Memo) need to be entered.

Source Type

RC = Receipt, SK = Stock

Source Doc#

Receipt Number or Stock Transaction identifier.

Source Line#

Receipt Line Item Number.

Create Date

The date parts were received into inspection.

Complete Date

The date the last unit was moved out of inspection.

Buyer

The Buyer who placed the Purchase Order.

Inspected By

Name of the Inspector.

Specification Code

The Specification Code assigned to the part defines Inspection parameters.

Sampling Plan

The Sampling Plan determines the number of units that must be inspected, and
criteria for rejecting the entire QA Lot.

Inspection Level

Normal, Reduced or Tightened.

Comments

Comments entered by the Inspector.
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Product Class

Product classification code from the PARTS master file.

Sub-Class

Product sub-classification code from the PARTS master file.

Manufacturer

The Manufacturer’s Name may be entered at time of Receipt.

Mfg. Part Number

The Manufacturer’s Part Number may be entered at time of Receipt.

Date Code

The Date Code may be entered at time of receipt.

Lot Number

Manfact inventory lot number.

Work Center ID

When a part is rejected during work-in-process, the Work Center identifier is
posted to the QA record.

WO Seq#

When a part is rejected during work-in-process, the operation sequence number
is posted to the QA record.

Detail
The Detail tab displays information for a QA record selected from the Results tab.
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Information on the Detail Display
Warehouse

The Warehouse the RI Location belongs to.

Part Number

Part Number to be inspected.

Description

Part Description

Part Revision

The Revision Level of the Part.

Supplier ID

Identifier of the Manfact Vendor file.

Supplier Name

Supplier’s Company Name

Lot Number

Manfact inventory lot number.

Product Class

Product classification code from the PARTS master file.

Sub-Class

Product sub-classification code from the PARTS master file.

Work Center ID

When a part is rejected during work-in-process, the Work Center identifier is
posted to the QA record.

WO Seq#

When a part is rejected during work-in-process, the operation sequence number
is posted to the QA record.

Source Type

Receipt or Stock Transaction

Source Doc#

Receipt Number or Stock Transaction Number

Source Line#

Receipt Line Number

Reference QA#

When parts are moved into a QA Controlled location from stocking location that
is not QA Controlled, a new QA Number is assigned by the system. When this
occurs, you may optionally reference another QA# where inspection was
previously completed.

Reference REC#

When parts are moved into a QA Controlled location from stocking location that
is not QA Controlled, a new QA Number is assigned by the system. When this
occurs, you may optionally reference a Receipt Number for information
purposes.

QA Location

The Receiving Inspection Inventory Location

Destination

The Ultimate Destination Inventory Location from the Purchase Order.

Status

Active – Some or all of the parts are still in the RI or MRB location.
Complete – All parts have been moved out of the RI and MRB locations.
Final – All required signatures and document numbers have been posted.
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Create Date

The date the QA record was created.

Complete Date

The date the Status of this record became Complete.

Final Date

The date the Status of this record became Final.

Needs Inspection

Total quantity awaiting inspection.

Needs Disposition

Total quantity awaiting disposition.

Ready to Move

Quantity ready to move out of RI and/or MRB.

Needs Notice

Disposition transactions are awaiting Approval, and a notification has not been
sent.

Needs Approval

Disposition transactions are awaiting Approval.

Needs Docs

Document numbers (ECR, CAR, SCAR, Debit Memo) need to be entered.
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Inspection
The Inspection tab allows you to view and maintain information about the inspection process.

The following fields may be updated using this view:
Manufacturer

Enter the Manufacturer Code, or use the command button to search for the code
using the Manufacturer Code Search screen.

Mfg. Part Number

The Manufacturer’s Part Number for the selected Manufacturer Code validated
against the Approved Manufacturers List in the PARTS file.

Date Code

The Date Code may be entered at time of Receipt.

QA Spec Code

Enter the QA Spec Code, or use the command button to access the QA Spec Code
Search screen. This entry initially defaults from the PARTS file.

Sampling Plan

A drop-down box is available to select from the list of Sampling Plans. Sampling
Plans are defined using the System Administration screen. This entry defaults
based on the QA Spec Code, and may be changed by the user.
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Inspection Level

A drop-down box is used to select Reduced, Normal, or Tight.

Sample Size

The system calculates and displays the required Sample Size based on the
Sampling Plan, Inspection Level, and QA Lot Size.

Comments

Free form notes.

Last Receipt Info

Messages at the top of the screen display the Date and QA Identifier of the last
receipt of this part number, and the number of units accepted and rejected.

Inspection Steps:
The list of Inspection Steps defaults from the QA Spec record and may be modified by the user.
Step

A brief description of the inspection step to be performed.

Completed By

Select the Inspector’s Name from the drop-down box.

Complete Date

Enter the date this step was completed.

The [Q/A Data Store] button will open the folder containing inspection instructions and other Q/A
related information for the Part Number. The name of the folder containing the QA data consists of the
Part Number, followed by a space, followed by a description.
The [Part Data Store] button opens the drawing file for the Part Number. The Drawing File Name may
be the Part Number alone, or the Part Number followed by “_”, followed by the Revision Letter.
Please refer to the Data Warehouse chapter for more information.
Click the [View Deviations] button to see a list of active QA Deviation records for this Part Number.
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Accept/Reject a QA Lot
Use this screen to enter the results of the Inspection process.

Enter the following information:
Date

Defaults to the current date

Inspected By

Select the Inspector’s Name from the drop-down list.

Inspected Qty

Defaults to the system calculated Sample Size.

Quantity Failed

The number of units that failed inspection cannot exceed the
Inspected Quantity.

Accept/Reject

The system determines if this is an Accept or Reject transaction
based on the rejection criteria defined by the Sampling Plan.
This value may not be changed by the user.
If a Sampling Plan was not used, or the Inspected Quantity is
less than the Sample Size, the transaction will be considered a
rejection if the Failed Quantity is greater than zero.
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Accept/Reject Code

Select the appropriate code from the drop-down list. Only
appropriate codes are included in the list, depending on whether
this is an Accept or Reject transaction.

Accept/Reject Qty

This value defaults to the QA Lot Quantity, less the number of
units previously accepted or rejected.

Stock Transaction Entry
This functionality is limited to the transfer of parts either to or from a QA Controlled Inventory
Location..

Enter the following information:
From Location

Select a Location from the drop-down list. Only those locations where the
parts associated with this QA record currently reside will be offered.

To Location

If the from location is Receiving Inspection, and there are rejected parts onhand in Receiving Inspection, this value defaults to the MRB location
defined for the Warehouse.
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If the from location is Receiving Inspection, and there are accepted parts onhand in Receiving Inspection, this value defaults to the Ultimate Destination
from the Purchase Order .
Quantity

Defaults to the quantity currently on hand at the From Location for this QA
record.

From Bin

This entry is required if the From Location is Bin Controlled.

To Bin Location

This entry is required if the To Location is Bin Controlled.

If the Inventory Location you need is not in the list, you may type it, or use the browse button to search
for the appropriate Inventory location. The following restrictions apply:





At least one of the locations, from or to, must be a QA Controlled Inventory location.
Movements to/from Adjustment, Purchasing and Cost Of Goods Locations are not permitted.
Transfers to/from Work in Process, Outside Processing, Direct Shipment, and In-Transit
locations are not supported.
When moving from a QA Controlled location to a stocking location that is not QA Controlled,
the transaction quantity may not exceed the Quantity Ready to Move on the QA record.

Quantity Ready to Move
Parts may be transferred freely between two QA Controlled locations, such as Receiving Inspection and
MRB. The Quantity Ready to Move out of the QA Controlled environment includes parts that have been
accepted and are ready to move to Stock, along with rejected parts whose disposition has been
determined.
Creating New QA Records
When parts are moved into a QA Controlled location from stocking location that is not QA Controlled, a
new QA Number is assigned by the system. When this occurs, the system displays a prompt as shown in
this example:
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When a new QA record is created in this manner, the “Reference QA#” and “Reference Receipt#” fields
are automatically updated with the original QA Identifier and Receipt Number. This feature is useful
when parts that were previously received into Stock are subsequently returned to Inspection.

Non-Conforming Material Report (NMR)
Use this screen to enter additional details to be printed on the Non-Conforming Material Report.

The browse button next to the Attachments prompt allows you to locate documents, drawings or other
files that may be attached to the NMR. When you attach a file, it is automatically copied to the NMR
folder where it may be accessed by members of the Receiving Inspection and Material Review Board
departments.
Click the [Create/Email NMR] button to generate the NMR as a Word Document, and optionally a PDF
file to be stored in the NMR folder. When created, the document may be emailed to a list of responsible
persons as defined in the System Administration function.
Click the [NMR Folder] button to view the folder containing documents and other attachments that may
be linked to the NMR.
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Information on this screen includes:
Problem Description

Free form text

Test Process

Briefly describe the testing performed.

Containment Action

Describe the Containment Action for Manufacturing Continuity
(e.g. Sorting, parts on-hold, 100% testing, etc.)

Defect Codes

A table of Defect Codes and Descriptions.

Affects
Functionality?

Yes or No

Detected When?

Receiving Inspection, In-Process, Dock Audit

Location

Area or Manufacturing Line

Shift

Reported during Shift

Specific cavities

Free-form entry.

Mold ID

Free-form entry.

Mfg. Dates/Shifts

Free-form entry.
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Disposition a Rejected QA Lot
Use this tab to enter Disposition and Approval information for a rejected lot.

Disposition Information:
Disposition#

The identifier of the QA.DISP file.

Date

Defaults to the current date

Quantity

Enter the Disposition Quantity

Status

N = Needs Approval
A = Approved
X = Cancelled (quantity will be set to zero)

Disposition

Select the appropriate code from the drop-down list.
The Disposition Code should indicate the action to be taken. For
example: Accept and Move to Stock, Return at Supplier’s Expense,
Return at Our Expense, Use As Is, and so forth.
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Type

The type of disposition, Accept or Reject, is associated with the
Disposition Code. This value is displayed by the system and may
not be changed.

Reason

The Disposition Code is associated to a “QA Code” which
determines Supplier Fault. For example:
Internal Error
Supplier is at Fault
Supplier Not at Fault

ECR# Required

Checkbox: Engineering Change Request is required.

CAR# Required

Checkbox: Corrective Action Request is required.

SCAR# Required

Checkbox: Supplier Corrective Action Request is required.

Debit Memo Required

Checkbox: Debit Memo is required.

Number of Approvals
Needed

Indicates the number of signatures required before the Disposition
may be finalized.

Number of Approvals
Received

The number of approval signatures posted to this Disposition.

Comments

Free-form multi-line text.

Requesting NMR Approval
Disposition#

If there are multiple Disposition transactions, indicate which one this Approval
applies to. The system defaults this entry to the first Disposition transaction where
approvals are needed.

Reviewer’s Name

Select the person’s name from the drop-down list.

Send Notice

Check this box if an email notification should be sent to this person notifying them
that their approval is requested. The email message will be sent when you click the
[Save] button. Once the message is successfully transmitted, the checkbox will be
automatically cleared.

Approve / Refuse

The Reviewer’s decision.

Entered By

The login identifier of the person who entered the Approval is updated by the
system and may not be changed. If the Approval was posted via the Web Site, the
system will update this field automatically and this value may not be changed.
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Entered Date

The date the Approval was entered is posted by the system and may not be
changed.

Comments

Free-form multi-line text.

Email Message:
Upon saving, an email message will be generated if you have clicked the “Send Notice” option on an
Approval request. Before sending notices, you must first create the NMR document. If you have not
already done so, the system will prompt you to create the NMR before sending the Request for
Approval.
If you have implemented the Supplier Portal Web Site, the Reviewer may enter their Approval or
Refusal via the web site. If the URL for the Supplier Portal Web Site has not been entered in the System
Administration screen, the link will be omitted from the Email Message.
Subject:

Approval Requested for Disposition of NMR# _____

Attachment: NMR Document
Body:

Please review the attached NMR document, and then click on this link to
Approve or Reject the NMR Disposition: (Web Link)
Supplier:

XXXXXXXXXXXXXXXXXXXXXXXXX (999999)

Part Number:

XXXXXXXXXXXXXXXXXXXX Rev: XX

Description:

XXXXXXXXXXXXXXXXXXXXXXXXX

Disposition:

XXXXXXXXXXXXXXXXXXXXXXXXX

Quantity

999999

Web Link:
A link in the email message will provide access to the NMR Approval web page. The format of the link
is: “http://URL/Page_Name?a=Approval_Number&b=Serial_Number”.
URL

The location of the Supplier Portal Web Site is entered using the System
Administration screen.

Page_Name

The name of the NMR Approval Page: NMR_Approve.asp.

Approval_Number Identifier of the NCC_QA_APPROVE record.
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Serial_Number

A system generated random number. If this value does not match the Serial
Number stored in the NCC_QA_APPROVE record, the user will not be
able to access the NMR Approval Page.

Returns
Use this screen to authorize returns to the Supplier.

Click the [Enter SCAR] button to create a Supplier Corrective Action Request.
Rework and Charge Backs
Work Order#

Enter the Work Order Number used for repair or rework of these parts.

Rework Hours

Internal hours associated with repair, special handling, etc.

Rework Cost

Internal cost associated with repair, special handling, etc.

Charge Back $

Amount to be charged back to the Supplier (for information only)

Charge Back
Acct#

The G/L Account Number associated with the Charge Back (for information only.
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ECR#

Enter the Engineering Change Request Number if required.

CAR#

Enter the Corrective Action Request Number if required.

SCAR#

This field is updated automatically by the system when a SCAR referencing this
QA/NMR# is created.

Returned Goods Authorization
RGA#

Enter the Returned Goods Authorization Number provided by the Supplier.

RGA Date

Enter the date the RGA# was provided.

Returns to the Supplier:
Debit Memo#

Select an existing Debit Memo Identifier from the drop-down list, or select (TBA) to
authorize a new Debit Memo.

Return Date

If you selected an existing Debit Memo Number, this value is displayed by the system
and may not be changed. If you are entering authorization for a new Debit Memo, the
estimated return date may be entered.

Qty Returned

If you selected an existing Debit Memo Number, this value is displayed by the system
and may not be changed. Otherwise, entry is required.

Reason Code

This value determines Supplier Fault, and may be changed for both proposed and
existing Debit Memos.

Supplier Fault?

Supplier fault is indicated by the Reason Code, and may not be manually altered.

Error Correct?

The Reason Code may indicate the transaction corrects an administrative error. This
value may not be manually altered.

Comments

Free-form multi-line text.
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Generate Non-Conforming Material Report (NMR)
This screen is displayed when you click the [Create/Email NMR] button on the NMR tab. It is used to
create the NMR document, which may be printed and/or emailed to the responsible people on the
Material Review Board. The document may be transmitted in either Word Document or PDF format.
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Email Settings
Use this view to create the email message. The information on this screen is initially filled in based on
entries made using System Administration screen, but may be adjusted here if desired.

NMR Document Format
See next page for a sample of the NMR Document format.
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Supplier Corrective Action Request (SCAR)
The Non-Conformance / Corrective Action Notice is a two-way communication device used when
defective parts are received from a Supplier. The primary functions are:





Formally notify the Supplier when defects are discovered
Obtain Supplier Feedback
Perform a final review to determine the impact on the Supplier’s Performance Rating.
Retain the SCAR document in a Data Store for future reference.

The main screen is comprised of seven tabs:
1. Search Options

Locate SCAR records using a variety of search criteria.

2. Search Results

View a list of SCAR records in spreadsheet form.

3. View / Create

View details from the associated Purchase Order line item.

4. Inspection

Entry of details regarding non-conforming material.

5. Notify Supplier

View and update Supplier’s contact information, and their response to this notice.

6. Review/Finalize

Determine whether Supplier is at fault and enter Reviewer’s comments.

7. Returns

Update Reason Codes on debit memos for the selected line item.
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Use the Search Options and Search Results tabs to locate existing SCAR records in your database. The
remaining tabs are used to view and update a specific SCAR record. A Navigator Bar on the upper right
corner of the screen allows you to scroll through a list of selected records.
To create a new record, choose the “New / Open” option from the File menu. You may also use this
option to open an existing record if you know the SCAR record identifier. For convenience, a button at
the bottom of tabs 3-5 is also available to invoke the “New / Open” option.
The SCAR record must be associated to a specific Purchase Order and Line Item Number. If your
company uses the Quality Control module, a QA Identifier may also be specified. When a QA Identifier
is entered, details about the inspection are automatically copied to the SCAR. Additional information
about the problem or defect may be entered using the Inspection tab.
Enter the Supplier’s contact information on the Notify Supplier tab. Click the “Word Doc” button on the
bottom of tabs 2-5 to generate the SCAR as a Microsoft Word Document, and optionally a PDF file, and
save it the BWB Data Store. Once produced, the SCAR document may be emailed to the Supplier.
When the document is emailed, a list individuals may be automatically copied, according to the options
entered in the System Administration screen.
The Supplier may respond by traditional means (phone, email, etc.) or they may visit the Supplier Portal
web site to enter comments regarding the SCAR. Once the Supplier’s comments are entered, the status
of the SCAR changes to “Pending Final Review”.
Verify the Reason Code (which determines fault) and change the status to “Final” to close the SCAR.

Search Options
You may fill in as many fields as desired to narrow your search. If you leave a field blank, it will be
ignored. Wildcard features are supported for all text fields. Click the “Search” button at the bottom of
the screen, and the qualifying records will be displayed on the Search Results tab.
Search Sets
The Search Set commands at the bottom of the screen allow each user to name and save their favorite
search options. Select an existing Search Set from the drop-down list, or simply type a description to
name a new Search Set.
Click the Save button to save the settings for the named Search Set. Click the Load button to recall the
saved settings. Click the Remove button to permanently delete the Search Set from the list.
Check the Save Dates box if you want the system to remember dates when settings are saved. If this
box is unchecked, all date fields will default to the current date.
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Search Results

Columns Included in Search Results:
PO#

Purchase Order Number.

PO LI

Purchase Order Line Item Number.

Seq#

Each SCAR is uniquely identified by the Purchase Order Number, PO Line
Number, and a system assigned Sequence Number.

QA / NMR#

The QA record identifier, which is also the identifier of the internal NonConforming Material Report (NMR).

Receipt Number

The Receipt Number from the QA record is displayed.

Status

The Status may be set to one of the following:
New, Notice Not Sent (N)
Open, Supplier Notified (O)
Pending Final Review (P)
Final Review Complete (F)
Cancelled (X)

Entry Date

The date the SCAR was created.

Supplier Notified

The date the SCAR was sent to the Supplier.
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Supplier ID

The identifier of the VENDOR file.

Supplier Name

The Supplier’s company name.

Warehouse

The Warehouse where the parts were originally received.

Buyer

The name of the Buyer who placed the Purchase Order.

Work Order#

The Work Order number used to rework or repair the defective parts.

Part Number

The Part Number from the Purchase Order line item.

Description

The Part Description from the Purchase Order line item.

Disposition

The Disposition Code determines the action to be taken (Return to Supplier, Scrap,
Use As Is, etc.).

Reason

The Reason Code (also known as the QA Code) indicates whether or not the
Supplier is at fault.

Supplier Fault

Yes or No as indicated by the Reason Code.

Reject Qty

The total quantity reported as defective.

Return Qty

The number of units returned to the Supplier via a debit memo.

Used As Is Qty

The number of non-conforming or defective units that were not returned.

Inspected by

The name of the person who performed the inspection.
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View or Create a SCAR
If you have used the search feature to produce a list of Supplier Corrective Action Requests on the
Results tab, you may use the navigator bar on the upper right corner of the screen to scroll through the
list. If you wish to create a new SCAR, click the New / Open button at the bottom of the screen.

Information on this screen includes:
PO Number

Purchase Order Number.

Line Number

Purchase Order Line Item Number.

Sequence Number

Each SCAR is uniquely identified by the Purchase Order Number, PO
Line Number, and a system assigned Sequence Number.

QA / NMR#

The QA record identifier, which is also the identifier of the internal NonConforming Material Report (NMR).

Receipt Number

The Receipt Number from the QA record is displayed.

Receipt Line Number

The Receipt Line Item Number from the QA record is displayed.
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QA Spec Code

The QA Specification Code from the QA record. This Code defines the
inspection requirements for the part, including the Sampling Plan.

QA Lot Quantity

The total quantity received.

Part Number

Part Number from the Purchase Order Line Item.

Part Revision

Part Revision Level from the Purchase Order Line Item.

Description

Part Description from the Purchase Order Line Item.

Manufacturer

The Manufacturer’s Name from the RECEIPTS record.

Manufacturer’s Part
Number

The Manufacturer’s Part Number from the RECEIPTS record.

Product Class

Product Classification code from the PARTS master file.

Product Sub-Class

Product Sub-Class code from the PARTS master file.

Supplier Number

Identifier of the VENDOR file.

Supplier Name

The Supplier’s company name.

Warehouse

The Warehouse where the parts were originally received.

Buyer

The name of the Buyer who placed the Purchase Order.

Order Type

Order Type from the Purchase Order line item.

Location

Receiving inventory location.

Project Number

Project Number from the Purchase Order line item.

Lot Number

The Inventory Lot Number from the QA record.
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Creating a New SCAR
Click the New/Open button at the bottom of the screen to create a new Supplier Corrective Action
Request.

Information on this dialog includes:
QA / NMR#

Optionally, you may associate the SCAR to an existing QA Identifier, which is the same
as the internal Non-Conforming Material Report Number. If entered, the system displays
the Purchase Order and Line Number automatically.

PO Number

If you do not wish to associate this SCAR to a specific QA record, enter the Purchase
Order Number instead. The browse button next to the PO Number prompt provides a
search screen for locating the Purchase Order and Line Item Number.

PO Line

Select the Purchase Order Line Number this SCAR applies to. If you entered a QA
Identifier, this entry is not required.

Sequence#

If one or more SCAR records have already been entered for this PO and Line Number,
you may select a Sequence Number from the drop-down list to open an existing record.
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Inspection
The Inspection tab is used to enter details about the non-conforming material.

Information on this screen includes:
Inspection Date

Select the date that the inspection took place

Qty Rejected

The total quantity of rejected or non-conforming parts.

Inspected By

Enter the name of the inspector

Preparer’s Name

Name of the individual preparing the SCAR

Preparer’s Email

Email address of the individual preparing the SCAR

Internal Notes

These notes do not print on any external documents.

Defect Code

Select the Defect Code from the drop-down window. Multiple defect
Codes may be entered. Note, Defect Codes and Descriptions are entered
using the System Administration screen accessible from the Tools menu.

Defect Code Description

The Defect Code Description is displayed, and may be modified if
desired.
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Problem / Defect
Description

Free-form multi-line text.

Notify Supplier

Information on this screen includes:
Supplier Notified Via

Select one of the following options from the drop-down list:
Not Notified, Email, Fax, Mail, Phone / In Person

Supplier Notified Date

The date the Supplier was notified.

Reply Due

The Supplier is expected to reply on or before this date. The
value defaults to the Supplier Notified Date plus 5 days.

Supplier Responded Via

Select one of the following options from the drop-down list:
Not Notified, Email, Fax, Mail, Phone / In Person. If the
Supplier responded via the Supplier Portal Web Site, this
information is updated automatically.
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Supplier Response Date

The date the Supplier responded. If the Supplier responded via
the Supplier Portal Web Site, this information is updated
automatically.

Supplier Contact Name

The name of the person who will respond to the SCAR.

Contact Phone

The phone number of the Supplier Contact. This information
initially defaults from the VENDOR file.

Contract Fax

The fax number of the Supplier Contact. This information
initially defaults from the VENDOR file.

Contact Email

The email address of the Supplier Contact. This information
initially defaults from the VENDOR file.

Root Cause

The Supplier’s explanation as to the root cause of the problem
or defect. If the Supplier responded via the Supplier Portal Web
Site, this information is updated automatically.

Corrective Action

The corrective action proposed by the Supplier. If the Supplier
responded via the Supplier Portal Web Site, this information is
updated automatically.

Action Effective Date

The date the Corrective Action is to be put into affect. If the
Supplier responded via the Supplier Portal Web Site, this
information is updated automatically.
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Review / Finalize

Information on this screen includes:
Status

The Status may be set to one of the following:
New, Notice Not Sent (N)
Open, Supplier Notified (O)
Pending Final Review (P)
Final Review Complete (F)
Cancelled (X)

Disposition Code

Disposition Codes are stored in Manfact’s DISPCODE file, and describe the
action to be taken. For example, Return to Supplier, Scrap, Use As Is, etc.

Reason Code

Reason Codes are stored in Manfact’s QA.CODE file. A flag on the QA.CODE
record indicates whether or not the Supplier is at fault.

Supplier’s Fault

The system displays Yes or No based on the Reason Code. If you wish to change
this value, you must change the Reason Code.

Debit Memo Id

If the SCAR is related to a Debit Memo, select the Debit Memo from the drop
down list
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Qty Returned

If a Debit Memo is entered, the quantity is displayed and may not be updated

Qty Used As Is

The number of defective units that will not be returned to the Supplier. For
example, they may be reworked, scrapped, or used for an alternate purpose.
If the Reason Code entered indicates the Supplier is at fault, entry of a Quantity in
this field will have a negative impact on the Supplier Performance Rating.

Work Order Number

Enter the identifier of the Work Order used to make repairs (optional).

Est. In-House Repair Hours

Enter the estimated time required to perform the repair (optional).

Supplier Charge Back

Amount to be charged back to the Supplier (optional).

Account Number

G/L Account Number for Charge Back (optional).

Reviewer’s Notes

The Reviewer’s comments will print on the SCAR document.

Returns
The Returns screen displays a list of all returns to the Supplier for the selected line item.
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The information included on this screen includes:
PO Number

The Purchase Order Number this SCAR applies to.

PO Line

Purchase Order Line Number.

Qty Ordered

Total PO Line Item Order Quantity

Qty Received

Total Quantity Received on this Purchase Order Line Item

Balance Due

Balance Due from Supplier

Returned for Replacement

Quantity returned to the supplier for replacement.

Returned for Credit

Quantity returned to the supplier for credit.

Rejects Used As Is

Qty Rejected but Not Returned.

Awaiting Inspection

Quantity received against this PO Line Item, but not yet inspected.

Total Rejected

The greater of Quantity Rejected using the Quality Control Module, or
total returns via Debit Memo.

Rejected %

Total Quantity Rejected / Total Quantity Received

List of Returns to Supplier:
Debit Memo Number

Identifier of the RECEIPTS file.

Return Date

Debit Memo Date

Qty

Quantity Returned

Reason Code

QA Code Assigned to the Return, determines Supplier’s fault. If you
change the Reason Code, the Supplier’s Performance Rating will be
updated accordingly.

Supplier’s Fault?

If checked, this transaction will have a negative impact on the Supplier’s
Performance Rating.

Error Correct?

If checked, indicates that this is an error correction only. Reduces the
Total Quantity Received for Supplier Performance Rating calculation
purposes.

Credit / Replace

Returns for replacement increase the Balance Due, returns for credit do
not.
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Print or Email the Supplier Corrective Action Request
Use this screen to generate a Microsoft Word Document, and optionally a PDF file, and store the
document in the BWB Data Store. Once produced, you may email the document directly to the Supplier
along with any desired attachments.

40

NorthClark Computing, Inc.

SCAR Sample Document
See sample on next page.
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Data Warehouse Management
The Quality Control and Supplier Corrective Action Request modules rely on the following Data Stores:





Part Drawings and Blueprints
Q/A Specifications
Non-Conforming Material Requests
Supplier Corrective Action Requests (BWB Data Store)

The System Administration function is used to define the location on your network where each Data
Store resides.
This example illustrates a view of the Parts Data Store for Record Identifier: 2001. Note that with the
exception of the titles, the format of this screen, and the options available, are the same for all Data
Stores.

Information on this Screen:
Record Identifier

Part Number, QA, or SCAR Record Identifier

Description

Part Description or Part Number
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File List

A list of files currently contained in this Data Store is displayed. Use the
checkboxes to select multiple items to Open, Print, or Delete.

Keep on Top

Check this box to keep the Data Store View on top of other Windows on your
desktop, so it stays visible.

Explore Folder

Click this button to launch an instance of Windows Explorer, open at the current
Data Store Folder. If desired, you can copy/paste or drag-n-drop to copy files from
the Explorer Window to the Data Store View File List. This option is
recommended for advanced users.

Add

A dialog is displayed allowing you to browse your computer network for files to be
added to the Data Store.

Delete

Choose this option to delete one or more selected files. Note, when a file is deleted
from the Data Store, it is moved to a folder called “Backup Files” where it may be
retrieved using Windows Explorer, if needed. The name of the file will be changed
to reflect the date and time it was saved, so multiple copies of the same file may
exist in Backup Files.

Rename

Choose this option to Rename the highlighted file. A box will be displayed
allowing you to edit or type over the existing file name.

Open

The program attempts to open the selected file(s) by launching the application
associated with the file extension.

Print

The program attempts to print the selected file(s) by launching the application
associated with the file extension.

Close

Closes the Data Store View.

Check All

Selects all the files in the list.

Uncheck All

Deselects all the files in the list.

Refresh

Redisplays the file list and Notes with currently information from the Data Store
folder.

Splitter Control

The white horizontal bar in the center of the screen allows you to adjust the size of
the top and bottom panels.

Edit Notes

Click this button to edit the Notes file for this Data Store. If the text file does not
exist, the program will create it automatically.

Notes Display

The system displays the Notes from the text file.
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Part Data Warehouse
This function may be accessed from the Tools Menu, or from the Inspection tab on the QA screen. It is
used to locate drawings and blueprints in the Part Data Warehouse.

Q/A Data Warehouse
This function may be accessed from the Tools Menu, or from the Inspection tab on the QA screen. It is
used to locate files in the Q/A Data Warehouse associated with a Part Number.

NMR Data Warehouse
This function may be accessed from the Tools Menu, or from the NMR tab on the QA screen. It is used
to locate files attached to a Non-Conforming Material Report.
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Supplier Portal Web Site
The Supplier Portal Web Site allows authorized guests to interact with the Purchasing and Supplier
Quality organization.
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The Main Menu is displayed upon successful login:
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Supplier Response to Corrective Action Request (SCAR)
Upon receipt of a Supplier Corrective Action Request (SCAR), the Supplier may visit the Supplier
Portal Web Site to enter their response. The Search Screen allows the Supplier to locate the desired
record.

The Supplier clicks on the “SCAR Number” link to open a record to view or update.
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The SCAR Edit Page allows the Supplier to submit their comments:

When the Supplier responds, an email notification is sent to the person who prepared the SCAR, and to
the list of individuals who were copied when the SCAR was originally transmitted.
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NMR Disposition Approval Page
This page is available for internal personnel to approve or reject the disposition of a Non-Conforming
Material Report (NMR). When the disposition of an NMR is entered, an email notification is sent to the
individuals who are asked to approve the proposed action (return to Supplier, use as is, etc.), along with
a copy of the NMR document. A link in the email message will direct the user to the NMR Disposition
Approval page.
This page is not available to Suppliers, and it cannot be accessed directly from an Internet browser. A
unique serial number embedded in the email message ensures that the page can only be accessed by the
intended party. Information on this screen includes:

If you are not [Reviewer’s Name], click here. (closes the web page)
NMR#

The QA Record Identifier
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Supplier

Supplier Name and Identifier.

Part Number

The identifier of the Part on the QA record.

Part Description

25 character description.

Part Revision

The Revision Level of the Part on the QA record.

Disposition

Description of the proposed action (return to supplier, use as is, etc.)

Quantity

The number of units on this Disposition.

Approve

Click this button to Approve the Disposition.

Reject

Click this button to Reject the Disposition.

Comments

Comments may be entered by the Approver.
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Data Entry and Maintenance
Deviation Authorization
Use this procedure to document an allowable deviation from established Quality Assurance
specifications and/or procedures. This data is for information purposes only, and does not impact the
user’s ability to accept or reject a given QA lot.
Authorized users may create and update Deviation records using this procedures (please refer to the
Security section for more information). Inspectors and other non-administrative personnel may use this
procedure for inquiry purposes.
Search Options
The Search tab allows you to locate QA Deviation records using a variety of search criteria.
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Search Results
This tab displays a list of QA Deviation records meeting your search criteria. To open a record for
updating, double-click on the row header, or highlight a row and click the Open button.
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Detail
Use this tab to create or update a QA Deviation record.

Use the navigator bar on the upper-right corner of the screen to scroll through the list of QA Deviation
records you have selected, or enter the desired record identifier at the Deviation Number prompt.
Assigning Deviation Numbers
Click the [New] button to start a new record. The system will assign the next sequential Deviation
Number when the record is saved. If you enter a Deviation Number that does not exist, an error message
is displayed, then the system asks you if you want to create it. This feature may be useful for entering
Deviations that were generated prior to implementing the NorthClark system.
Prompts on this Screen
You must enter a Part Number, Authorization Date, and Expiration Date. All other prompts are optional.

54

NorthClark Computing, Inc.
Parts Master Update
The Q/A Parts Master Update screen is accessible from the Data Entry menu on the Main screen.

This prompts at the top of the screen allow you to search for a list of Manfact PARTS records to be
updated. To use this feature, enter the desired filters and then click the [Search] button.
Clicking the browse button next to the Part Number prompt will initiate the NorthClark Part Number
Search Query, which offers more extensive search features. Click the [Use Last Parts Query Results]
button to copy the list of Part Numbers from your last search into the list below.
If you wish to update a specific Part Number, simply type it into the blank row at the bottom of the
spreadsheet. Note, you may only enter existing Part Numbers. New records may not be created using
this procedure.
In the Manfact system, the “QA Required” flag exists in both the PARTS and PARTSDTL files. The
flag in the PARTSDTL file allows you to enter a different value for each “Cost Group”, while the flag in
the PARTS file serves as a default value. The check box list at the bottom of the screen let’s you choose
the Cost Groups that should be updated. Most companies have only one Cost Group, and under these
circumstances, the box should always be checked.
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Once you have entered a Part Number into the spreadsheet, or loaded a list of Part Numbers using the
Search features, you may edit the Q/A related fields. Click the [Save] button to post your changes to
Manfact.
The columns on this screen include:
Part Number

This entry must exist on the Manfact PARTS master file.

Description

This Part Description is displayed by the system and may not be updated.

Make / Buy

The Make/Buy flag is displayed by the system and may not be updated.

QA Required?

Check this box if this Part Number normally requires inspection upon
receipt, even if inspection may be bypassed based on “Skip Lot”
parameters. Uncheck this box if the part never requires inspection.

QA Spec Code

Q/A Specification Codes define the rules for inspecting each type of part,
including inspection steps, and optionally a statistical sampling plan. Please
refer to the QA Specification Code entry topic for more information.

Inspection Level

The Inspection Level is used in Sampling Plan calculations. Valid entries
are Normal, Reduced and Tightened. The value entered here is used only
when an Inspection Level as not been entered for the Supplier using the
Skip Lot Parameter entry screen.

QA Notes

Free form multi-line text.
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QA Specification Codes
In the Manfact system, the QA.SPEC.N procedure is used to define Quality Assurance Specification
Codes, which can be assigned to parts via the PARTS.ALL procedure. Users who normally have access
to Manfact's QA.SPEC.N procedure will be able to create, modify, and delete Q/A Specification Codes
using the NCC_QC program.

Note: A QA.SPEC record may not be deleted if it is referenced on an existing QA record.
The fields below are available in addition to the information currently available in the Manfact version:
Specification Code:

A command button has been provided to allow access to the QA
Specification Code Search screen.

Type of Sampling

Options are: Test a Random Sample, or Test Each Piece.

57

NorthClark Computing, Inc.
Sampling Plan:

A drop-down list is provided to select from the list of available Sampling
Plans. Note, this prompt is disabled if the Type of Sampling is not “Test a
Random Sample”
If a detailed Statistical Sampling Plan has been provided, the following
prompts are disabled: % To Be Tested, Qty to Be Tested, %=Total
Rejection.

% To Be Tested

If you have chosen Random Sampling, but do not wish to use a statistical
Sampling Plan, enter the percentage of the total QA Lot Quantity to be
tested.

Minimum Qty to Test

If you have chosen Random Sampling, but do not wish to use a statistical
Sampling Plan, enter the minimum number of units to test. The Sample
Size will be the greater of “% To Be Tested” or “Minimum Qty to Test”.

% = Total Rejection

If you have chosen Random Sampling, but do not wish to use a statistical
Sampling Plan, enter the Defect Rate (Failed Quantity / Sample Size) that
will cause the entire QA Lot to fail.

Description

Free form text entry.

Test Definition

Free form text entry.

Inspection Steps:

This multi-valued prompt will allow the user to create a sequential list of
steps that must be performed to complete the inspection process. When the
Inspection Report is entered, the Inspector’s Name and Inspection Date
will be entered for each Inspection Step.

58

NorthClark Computing, Inc.
Sampling Plans
Each Sampling Plan will have a table of values used to calculate the Sample Size required for each QA
Lot, along with the Reject Quantity for both Normal, Tightened and Reduced Inspection Levels. For
example:

The Specification Code assigned to the Part Number determines the Sampling Plan to use. The
Inspection Level assigned to the QA record indicates Normal, Tightened, or Reduced. If the number of
failures is greater than or equal to the Reject Quantity, the entire QA Lot will fail.
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Skip Lot Inspection Parameters
In the Manfact system, a flag in the PARTSDTL record determines whether or not the item will require
quality inspection upon receipt. When this option is enabled, the part is automatically transferred to the
Receiving Inspection location when the item is received against a Purchase Order. The NorthClark
Quality Control module enhances this feature by allowing you to specify additional parameters used to
determine when the part will require inspection.

This screen is accessed from the Tools Menu and is used to define the “Skip Lot” inspection parameters
for each Part Number, Supplier Number, Manufacturer and Manufacturer’s Part Number combination.
These parameters will be used to determine when a given receipt will be allowed to skip inspection.
Delete Checkbox
Check this box if you wish to permanently delete this record. This action causes the row to turn red. The
record will be removed when you click the [Save] button.
Enable Skip Lot?
Check this box to allow inspection to be periodically bypassed for this Part Number, Supplier Number,
Manufacturer and Manufacturer’s Part Number combination.
# of Lots to Skip
Enter the number of times this item may skip inspection, after which inspection becomes mandatory for
the next lot received.
Inspection Level
The Inspection Level is used in Sampling Plan calculations. Valid entries are Normal, Reduced and
Tightened. If left blank, the Inspection Level indicated on the NCC_PARTS file is used.
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Create New Non-Inventory QA Record
QA records are normally created automatically by the system when parts are received into a QA
controlled location via a Purchase Order Receipt or a Stock transaction. However in some cases, it may
be desirable to report a quality failure for items that are not currently in inventory. After creating a NonInventory QA record, you may enter Inspection results, generate a Non-Conforming Material Report
(NMR) and record Disposition and Approval information. If a Vendor Number is supplied, the system
will automatically update Vendor Performance statistics.

•

Click the [New] button to clear the screen and begin entering data on a new record.

•

Click the [Open] button to access a Non-Inventory QA record created previously. Note, you may
not update Inventory type QA records using this screen.

•

Click the [Save] button to save your work. The system will automatically assign a QA/NMR# to
new records.

•

Click the [Close] button to return to the Main screen. The last Non-Inventory QA record you just
created or updated will automatically be displayed on the main screen, ready for your to add
addition information and create the NMR document if desired.
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Tools
The options described in this section may be accessed from the Tools Menu.

Part Number Search
The Part Number Search query helps you locate a Manfact Part Number using a variety of search
criteria. This procedure is for inquiry purposes only, and does not allow records to be updated.

Supplier Search
Use this view to locate Suppliers in the Manfact VENDOR file. Wildcarding may be used to enter part
of the Supplier Name as shown in this example.
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Manufacturer Search
Use this option to locate Manufacturer Codes stored in Manfact’s MANFR file.

QA Specification Code Search
Use this view to locate QA Specification codes stored in Manfact’s QASPEC file.
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PO Search
Use this screen to locate Purchase Orders using a variety of search criteria.

Enter your selection criteria, and then click the Search button. You may use as many fields as desired to
narrow your search, and wildcarding is supported for text fields.
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Search Results
When the search is complete, the list of qualifying records will be displayed on the Search Results tab:

If you accessed this screen from a prompt that permits entry of one or more Purchase Order Numbers,
click the checkboxes in the first column to choose the desired PO Numbers. Use the Select All and
Select None buttons at the bottom of the screen to check or uncheck all of the boxes.
Click the OK button when you are finished selecting Purchase Orders.
Double-click on a row to view line item details for the selected Purchase Order.
Columns Displayed for PO Search Results:
Select

Use the checkbox to select or de-select a Purchase Order.

PO #

The identification number for the PO.

Date

The creation date for the PO.

Supplier ID

Number or Code assigned to a specific Supplier (Vendor ID).

Supplier Name

Name of the Supplier/Vendor
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Status

PO Value

The current status of the Purchase Order:


New: There have been no receipts against the purchase order.



Backordered: There has been a receipt against the purchase order and
there is a quantity remaining to be received



Closed: All line items have been fully received



Closed and Paid: All Line items have been fully received and paid for.

The total value of the Purchase Order.

PO Search – Detail
This screen displays the line item detail for a selected Purchase Order.

If you accessed this screen from a prompt that requires input of a specific Purchase Order Line Item, you
may use the checkboxes in the first column to select the desired line item. Click the OK button once the
desired line items has been located.
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Columns Displayed for PO Line Item Detail:
Select

Use the checkbox to select or de-select a line item.

PO Line#
Part Number
Description
Work Order#
Warehouse
Inventory Location
Receipt Qty
Unit of Measure
U/M Factor
Unit Cost
Ext. Cost
Cost Factor
Cost Conversion
Tax Type
Resource Code
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Reports
Receiving Inspection Report
The Inspection Report will be generated as an Excel spreadsheet that may be printed or stored
electronically. It may be created for a specified QA Id as an input document prior to inspection, and it
may also be used to produce a report after the QA information has been entered.
The System Administration is used to define the starting path for the Inspection Reports. Each file will
be created with a unique name that includes the QA Id, Creation Date and Creation Time.

The user is prompted for the following information:
QA ID

Defaults to the selected QA Identifier from the QA Detail View

Template File Name

The name of the Excel template to be used for Inspection Report.

Max # of Transactions

The maximum number of the most recent transactions to be exported

The report has three parts; a header section with information about the current QA Inspection
transaction, an inspection "sign-off" section, and a history section listing previous inspections for the
part number.
Header Section: QA Identifier, Part Number, Part Description, Product Class, Product Sub Class,
Inspection Level, Date Code, Sampling Plan, Manufacturer Name, Manufacturer Part Number.
Sign Off Section: Inspection Steps, Inspector Name, Complete Date
History Section: Transaction Date, Transaction Type, Source Document, Supplier, Manufacturer, Lot
Number, Date Code, Lot Size, Sample Size, Quantity Accepted, Quantity Rejected, Disposition,
Completed By, Remarks
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Report Sample

Inspection History Report
The Inspection History Report will be generated as an Excel spreadsheet that may be printed or stored
electronically. It may be created for a specified QA Id. The System Administration will be used to
define the starting path for the History Reports. Each file will be created with a unique name that
includes the QA Id, Creation Date and Creation Time.

The user is prompted for the following information:
QA ID

Defaults to the selected QA Identifier from the QA Detail View

Template File Name

The name of the Excel template to be used for Inspection History Report

Max # of Transactions

The maximum number of the most recent transactions to be exported

The report consists of the following information: Transaction Date, Transaction Type, Source
Document, Supplier, Manufacturer, Lot Number, Date Code, Lot Size, Sample Size, Quantity Accepted,
Quantity Rejected, Disposition, Completed By and Remarks.
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Report Sample:
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System Administration
The System Administration screen is accessed from the Tools menu, and is used to define various
parameters that are necessary for the system to function properly. You must have appropriate security
clearance to gain access to the System Administration function. This view is comprised of the following
tabs:
1.
2.
3.
4.
5.
6.
7.
8.

General
People
Defect Codes
QA Reason Codes
Disposition Codes
Locations
Non-Conforming Material Reports (NMR)
Supplier Corrective Action Requests (SCAR)

General

Data Stores
Q/A Specifications, Non-Conforming Material Reports, Supplier Corrective Action Requests and Part
Drawings may be stored in an electronic data warehouse. Enter the path name or use the browse button
to locate the root folder for each Data Store.
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Note that Supplier Corrective Action Requests are stored in a sub-folder of the BWB Data Store making
them accessible to the Supplier Portal Web Site. Enter only the root folder to the BWB Data Store; the
system will create the sub-folders automatically.
If you have already entered the Data Store Pathnames using the NorthClark Data Warehouse
Management (NCC_DWM) application, this information will be filled in automatically.
Automatic Email Notices
The system may generate automatic email notifications when: (1) approval is required for the disposition
of rejected parts, and (2) when a Supplier responds to a Corrective Action Request via the Supplier
Portal Web Site.
Supplier Portal URL

The web address of your Supplier Portal Web Site (Universal Resource
Locator).

From Email Address

The “From” email address to be used for system generated messages.

Enable Skip-Lot Inspection
Check this box to enabled the Skip Lot Inspection feature.

People
Create a table of Names to be used when updating QA and SCAR records. The Login Identifier must
exist in the Manfact OPER file. Peoples names are displayed by the system and may not be changed.
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People Columns
Login Id

The Login Name must exist on the Manfact OPER file.

Person’s Name

The name from the OPER file is displayed and may not be changed.

Person’s Initials

Enter the person initials for printing on reports.

Email Address

Enter this person’s email address for sending notifications.

Warehouse

Select the Warehouse where this person works. If entered, this person will
receive email notifications only when the event occurs within their
warehouse. If you choose “All Warehouses”, the person will receive
notification for all transactions.

Is Inspector

Check this box if want this person’s name to appear in the drop-down list
of Inspector Names.

Approves NMR

Check this box if want this person’s name to appear in the drop-down list
of Approver Names.

Prepares SCAR

Check this box if want this person’s name to appear in the drop-down list
of SCAR Preparer Names.

Email NMR

Check this box if this person should be included in the email distribution
of Non-Conforming Material Reports.

Email SCAR

Check this box if this person should be included in the email distribution
for Supplier Corrective Action Requests.

Delete?

Check this box if you wish to permanently delete this record. This action
causes the row to turn red. The record will be removed when you click
the [Save] button.
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Defect Codes
Defect Codes may be entered on both Non-Conforming Material Reports and Supplier Corrective
Action Requests to help standardize defect types and descriptions.
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QA Reason Codes
Use this procedure to define QA Reason Codes for both Inspection and Disposition purposes.

Reason Code Columns:
Reason Code

User defined accept or reject code.

Type Code

A = Accept, R = Reject

Description

Free form multi-line text.

Impact Vendor Performance

Enter a “Y” if this QA Code should impact the Supplier’s performance
rating.

Filed in Error

Enter a “Y” if this Reason Code is used to correct internal administrative
errors.

Inspection or Disposition?

This is a new prompt that will be added to support the NorthClark
Quality Control module (see below).
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The QA Reason Codes serve two separate purposes in Manfact:



Entered by the Inspector to indicate Acceptance or Rejection of a lot quantity.
Entered on Debit Memos to indicate Supplier Fault.

Arguably, the indication of Supplier Fault should really be a function of the Disposition Code, not the
Reason Code. To address this discrepancy, the NorthClark system allows you to create separate QA
Codes for each purpose.
When the Inspector enters an Accept/Reject transaction, only those QA Codes flagged as “Used for
Inspection” will be included in the drop-down list. When a Debit Memo is proposed, only those codes
flagged as “Used for Disposition” will be offered.
Note that entry of the “Impact Vendor Performance” and “Filed in Error” prompts are only applicable to
QA Codes that are used for Disposition.

QA Disposition Codes
QA Disposition Codes define the action to be taken when material is rejected (Return to Supplier, Use
As Is, etc.)

QA Disposition Code Columns:
Disposition Code

User defined.

Type Code

A = Accept, R = Reject
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Description

Free form multi-line text.

QA Code for Debit Memo

If this Disposition Code is used for returns to the Supplier, select the QA
Code that should be assigned to the Debit Memo. The available options
will be displayed in a drop-down list. For example:
Internal Error
Supplier Fault
Supplier Not at Fault

Number of Approvals

Indicates the number of signatures required before the Disposition may
be finalized.

ECR# Required

Checkbox: Engineering Change Request is required.

CAR# Required

Checkbox: Corrective Action Request is required.

SCAR# Required

Checkbox: Supplier Corrective Action Request is required.

Debit Memo Required

Checkbox: Debit Memo is required.

If the Disposition Code indicates that an ECR, CAR, SCAR or Debit Memo is required, the associated
document number must be entered on the Disposition record before it may be finalized.
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Warehouse Locations
This view allows you to enter parameters unique to each Warehouse. Warehouse Codes are defined in
Manfact. You may not create new warehouses using this procedure.

Location Columns:
MRB Location

Enter the MRB location for each Warehouse. This will be used as the default
destination location when rejected parts are moved out of Receiving Inspection.

NMR Template

The Word Document Template used to create Non-Conforming Material Reports for
this Warehouse.

SCAR Template

The Word Document Template used to create Supplier Corrective Action Requests
for this Warehouse.
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Non-Conforming Material Reports (NMR)
Use this view to create a default email message body for NMR notifications.
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Supplier Corrective Action Requests (SCAR)
Use this view to create a default email message body for Supplier notifications. You may also enter a list
of standard attachments to be included along with the SCAR document.
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Security
Access to NorthClark applications is governed by the Manfact security system. In order to access the
NorthClark Quality Control module, one of the following commands must be added to the user’s
Manfact Security Table:
NCC_QC

-

Normal access to the NorthClark Quality Assurance module

NCC_QCADMIN

-

Ability to use all features of NCC_QC, including access to the
System Administration screen.

NCC_SCAR

-

Can create and transmit SCAR documents to Suppliers.

NCC_SCARADMIN

-

Same as NCC_SCAR, plus access to the System Administration.

One or more of the following entries may also be included to authorize additional privileges.
NCC_QCNEW

-

Manually create new QA records

NCC_QCPARTS

-

Update Quality Control parameters in the Parts Master

NCC_QCSKIPLOT

-

Modify “Skip Lot” parameters for Parts

PARTS.ALL

-

Update Quality Control parameters in the Parts Master

PARTS.EN

-

Update Quality Control parameters in the Parts Master

PARTS.PC

-

Update Quality Control parameters in the Parts Master

QA.ACT.N

-

Ability to Accept or Reject a QA Lot

QA.DISP.N

-

Ability to Disposition a QA Lot

QA.SPEC.N

-

Authorization to create or modify QA Specification Codes,
Sampling Plans, and QA Deviation records.

STOCK.N

-

Create Stock Transactions to move parts in or out of a QA Location
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General Information
Export to Excel
All spreadsheet views are equipped with the option to Export to Microsoft Excel. Click on the
spreadsheet your wish to export, then choose the Export to Excel option from the menu or toolbar.

Export to Excel or to a File?
You may export the contents of the display directly to Excel, or you may choose to create a file in Excel
format.
Sheet Name
Enter the Excel sheet name to create. This will automatically default to Sheet1.
Save As File Name
Enter the pathname of the file you wish to create. You may Browse the files by clicking the button to
locate the drive and folder where the file will be stored.
Generate Warning List?
Select this option to create a log file. The log file contains error messages and other information about
how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will be stored
in the same folder as your spreadsheet.
Include Header
Check this box to export the column headings.
Export Button
Click this button to export your data to Microsoft Excel.
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Print a Spreadsheet
All spreadsheet views are equipped with a Print feature. Click on the spreadsheet you wish to print, then
choose the Print option from either the menu or the toolbar.

Range - Selecting a Print Range
You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted on
the current screen), the current page (only the rows that are currently visible on your screen), or a range
of page numbers.
Orientation - Portrait or Landscape
You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in
landscape mode will allow you to fit more columns of information on your report.
Margins - Report Margins
You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce the
left and right margins if you need to fit more columns on the report.
Units - Inches or Centimeters?
Are the margins you entered expressed in inches or centimeters?
Page Order
If your report is too wide, it may span multiple pages. When this occurs, do you want the report printed
from top to bottom or left to right?
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What Do You Want to Print?
You can customize the appearance of your report by printing (or not printing) column headers, row
headers, grid lines, borders, shadow, and color.
Headers and Footers
Your report may have up to three lines for the heading, and one line for the footer. The system initially
displays a default heading, which you may modify if desired.
Tip: Use /p to designate a page number.
Which Columns Do You Want to Print?
The columns that are available for printing are listed. Select the columns you wish to include on your
report.

Arranging / Hide Columns
Use this view to change the sequence in which columns appear on your spreadsheet.

Each column represents a field that is available for display on the spreadsheet. To hide a column
remove the check from the box under the title heading. Use the [Move First], [Move Left], [Move
Right] and [Move Last] Buttons to re-arrange the order in which the fields appear on the specific screen
Display. Click [Reset to Default] to return to the system’s default settings. Select the Number of
Columns and Rows you with to Freeze on the Display. Note, these settings are stored in the Windows
Registry for each user.
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Wildcardinged in the Windows Registry for each user.
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Wildcarding
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or
end of your search entry. You can also use “+” and “,” to include and/or conditions. Here are some
examples of search commands and their expected results:

…FREIGHT… or *FREIGHT*

Search for the word “FREIGHT” anywhere in the field

*FREIGHT*+*EXP*

Both “FREIGHT” and “EXP” must appear in the field

*FREIGHT*,*TAX*

Either “FREIGHT” or “TAX” must appear in the field
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